
 

1

 

Introduction

 

This document explains how to set up the PD3000 to act as an interface between a Profibus DP industrial 
network and an ALPHA sign network (as illustrated below):

 

NOTE: In the event of a communication failure, caused by any means, messages may not be displayed on a 
sign.

 

Specifically, this document describes how to:

• connect the PD3000 to a Profibus DP PLC

• connect the PD3000 to one or more ALPHA signs

• use the 

 

PD3000 Configuration Editor

 

 software to set up the PD3000 so that it interfaces between a Profibus 
DP PLC and an ALPHA sign network.

 

Related documents

 

Document name Part number Description

 

Gateway Messaging Software User Manual 9703-7004
Describes how to use Adaptive’s Gateway Messaging Software to 
store messages in ALPHA signs.

Network Configurations 9708-8046A Explains how to network ALPHA signs.

How to connect ALPHA signs to Profibus DP
using the PD3000
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PD3000 description

 

The PD3000 is an intelligent Profibus PD-to-serial communications interface unit. It allows data exchange 
between a Profibus DP host and ALPHA signs equipped with the Gateway firmware option.

 

Operating modes

 

Using the PD3000’s DIP switches, the unit can be set to either one of two types of operation: Normal Operation 
Mode or Configuration Mode.

•

 

Normal Operation Mode (DIP switch settings: 1, 2, 3, 4 = OFF)

 

 — In this mode, Ports 1, 2, and 3 are all active. 
The PD3000 will first wait for configuration from the Profibus DP host before initiating with the ALPHA 
sign(s).

•

 

Configuration Mode (DIP switch settings: 1, 2, 4 = OFF; 3 = ON)

 

 — In this mode, only Port 3 is active. Ports 1 
and 2 are 

 

not

 

 active. This mode is used to set up the various PD3000 parameters (e.g., baud rate, PLC 
address, etc.) with the 

 

PD3000 Configuration Editor 

 

software.

 

Item Name Description

A

 

Port 3 LED
Green = transmitting data
Red = receiving data

 

B

 

STATUS LED
Flashing green = unit initialized OK and is in Configuration Mode.
Flashing red = Profibus error.

 

C

 

DIP switches
Use these switches to set the operating mode of the unit:
Normal Operation Mode (used to relay PLC data to ALPHA signs): 1, 2, 3, 4 = OFF.
Configuration Mode (used to program the PD3000): 1, 2, 4 = OFF; 3 = ON

 

D

 

Port 1 LED
On = Communication established between Profibus host and PD3000.
Off = No communication established between Profibus host and PD3000.

 

E

 

Port 3 (“passthrough port”)
Connect to a personal computer that is running the

 

 PD3000 Configuration Editor

 

 software 
and the 

 

Gateway Messaging Software

 

.

 

F

 

Power connector Connect to a DC power supply of 7 to 28 volts rated at 9 watts.

 

G

 

Port 1 Data input from a Profibus DP host.

 

H

 

Port 2 Data output to one or more ALPHA signs.

 

I

 

Port 2 LED
Green = transmitting data
Red = receiving data
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PD3000 interconnection diagram

 

Item Part # Description

A

 

1188-0005

DB9-to-DB25 Configuration Cable to Port 3

 

B

 

—

Profibus cable to Port 1

1

ON

2 3 4

STATUS

2 3

PROFIBUS

SERIES

+
–

A

B

C

D

E

F

G

Port 2

Port 3

Computer

(RS485)
DB9 Female

TXD03

RTS 07
GND 05
RXD 02

CTS 08
DCD 01

DSR 06
DTR 04

PD3000

(RS485)
03 RXD
02 TXD
07 GND

DB25 Male

PD3000

03 V-
02 CAN_L

DB9 Male

05 Shield
07 CAN_H
09 V+
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C

 

1188-9101

DB25-to-3-wire cable to Port 2

 

D

 

1088-8000 RS485 cable

 

E

 

4331-0602 Modular Network Adapter (NOTE: On some ALPHA signs, this adapter is inside the sign.)

 

F

 

1088-8636 1 foot, 4-conductor RS485 cable (NOTE: If the Modular Network Adapter is inside the ALPHA sign, this cable is not necessary.)

 

G

 

1088-9105A DB25-to-DB9 adapter (for DB25 computer COM port)

to Modular
Network Adapter
Stripped wires

(RS485)
+

-

PD3000

(RS485)
DB25 Male

23 Tx+

22 Rx-
21 Tx-
24 Rx+

01 SHIELD
04 RTS

12
11
10
09
05 CTS

WHBL

BR

YL

GN

OR

BK

RD

WHITE
WIRE

BLUE
WIRE

For PD3000 units with revision F 
or earlier, terminating resistors 
are provided within the unit. Other 
terminating resistors in the 
system must be removed.

For PD3000 units with revision G 
or later, jumpers 9-10 and/or 11-
12 must be clipped if terminating 
resistors are elsewhere in the 
system.

Modular
Network
Adapter

to sign

BK YL
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PD3000 setup instructions

 

1. Attach a personal computer to the PD3000. (See “PD3000 interconnection diagram” on page 3.)

2. Put the PD3000 into Configuration Mode by setting DIP switch 3 to the ON position.

3. If not already installed, install the 

 

PD3000 Configuration Editor

 

 DOS software on the personal computer 
that will be used to program the PD3000.

 

Project file creation

 

4. Start the 

 

PD3000 Configuration Editor

 

 software. A screen similar to the following will appear.

5. Create a new “project” file by selecting 

 

Project > New

 

:

6. Click 

 

Ok

 

 and then save the project by selecting 

 

Project

 

 > 

 

Save

 

.

 

COM port setup

 

7. Select 

 

Options

 

 > 

 

Set COM Port

 

 and choose the PC COM Port you will use to communicate with the PD3000. 
(The default is COM 1.)

8. Select 

 

Save

 

. You will be notified that the information was saved. Click 

 

Ok

 

 to exit this screen.

9. (Optional) Once a COM Port is selected, you may wish to save this setting by selecting 

 

Options

 

 > 

 

Default 
Options

 

. If you do not do this, the COM port setting may revert to a former setting. The COM port setting 
is not part of the project, so saving the project will not save the COM port setting.

Close box

Enter a name for the new project file

Select Profibus to PLCs/Devices 
for Project Type

HINT: You can 
also choose an 
existing project by 
double clicking on 
the project name 
shown to get a 
drop-down list.



 

6

 

PLC communication (Port 1) setup

 

10. Select 

 

Edit

 

 > 

 

Port 1 (Profibus)

 

 to set up Port 1 on the PD3000:

11. Select 

 

Save

 

. You will be notified that the information was saved. Click 

 

Ok

 

 to exit this screen.

 

ALPHA sign communication (Port 2) setup

 

12. Select 

 

Edit > Port 2 (PLCs)

 

 to set up the PD3000 so that it can communicate with ALPHA signs equipped 
with the Gateway firmware option:

13. Save the settings for Port 2. You will be notified that the information was saved. Click 

 

Ok

 

 to exit this 
screen.

 

“Passthrough” port (Port 3) setup

 

14.  Select 

 

Edit > Port 3 (Passthrough

 

) to set up Port 3.

15. Select 

 

Save

 

. You will be notified that the information was saved. Click 

 

Ok

 

 to exit this screen.

See your industrial 
network administrator 
for the Profibus Address 
of PD3000.

These are the default settings.
Use these settings for Port 2:
• Halt Communications on Loss of Profibus = 

Check this only if you want to stop sending 
messages to signs if communication fails for 
the Profibus.

• PLC/Device Protocol = Modbus ASCII
• Communications: 2-wire RS422 or RS485
• DTU Address: 0
• Baud Rate: 9600
• Data Bits: 7
• Parity: Even
• Stop Bits: 2
• RTS Control: None
• Response Time-Out: 500 ms (recommended)

Use these settings for Port 3:
• Communications: Leave 

unchecked for RS232
• Baud Rate: 9600
• Data Bits: 8
• Parity: None
• Stop Bits: 1
• RTS Control: None
• Intermessage Time-Out: 100 ms



 

7

 

ALPHA sign register setup

 

16. Select 

 

Edit

 

 > 

 

I/O Configuration

 

 window and select 

 

Output Data

 

 to set up what data the PD3000 will transmit 
to the ALPHA signs. The 

 

Output Data Table

 

 screen will appear.

17. In the 

 

Output Data Table

 

, you can press 

 

Return

 

 for the specific 

 

Word

 

 to use, or you can double click on that 
line. Then check the box to see the entries for that 

 

Word

 

. 

Select
Output Data.

Check Use Output Word 1.

The ALPHA sign address

Recommended Delay Time = 500 ms.

One of the sign’s registers of where 
information is going to be stored.

To assign a new register, use the arrow keys 
or the mouse to move the highlight bar to 
an empty space and then press Return.
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18. Here is an example of several settings.

19. Select 

 

Save

 

 for the 

 

Output Data Table

 

 window to save all the register settings you just entered. Then select 

 

Ok

 

 twice.

 

Check the PC’s communication port

 

20. Before downloading your project settings to the PD3000, double-check your PC’s COM Port settings. To do 
this, select 

 

Options

 

 > 

 

Set COM Port

 

 and verify that the Port is correct. Change if necessary, then select Ok. 

Download the project settings to the PD3000

21. If you haven’t already done so, put the PD3000 into Normal Operating Mode by setting all DIP switches to 
the OFF position.

22. After you have completed making changes to the setup parameters, download the project settings to the 
PD3000 by selecting Transfer > Download project to PD3000 and follow the prompts, such as shown here.

Example Output Data Table settings

In this table, 
PLC Numbers are 
actually ALPHA 
sign addresses.

In these example settings,
• ALPHA sign address #2 Register 101 = activation register 

for this ALPHA sign.
• ALPHA sign address #2 Register 102 = deactivation register 

for this ALPHA sign.
• ALPHA sign address #2 Register 1 = a variable value stored 

in this ALPHA sign.
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Safety and troubleshooting

When successfully connected to a Profibus DP industrial network, there should always be some type of 
message on each ALPHA sign connected to this network:

Messaging example

To help you understand how to program the PD3000 and how it works with a PLC and ALPHA signs, a 
complete messaging example follows.

The big picture

The example

Here’s the situation:

• In this example factory, there’s a conveyor belt and an automated lathe connected to a Profibus DP PLC 
(whose address = 5). This PLC is connected to a PD3000 (whose address = 3) and to two ALPHA signs 
(whose addresses are 7 and 8).

NOTE: Sample PLC register addresses are used in this example.

• On the ALPHA sign with address = 7, you want to display a message about the conveyor belt: Conveyor 
Belt On: Speed = [a number representing the belt speed], Conveyor Belt Off, and Motor Overload.

• On the ALPHA sign with address = 8, you want to display status messages about the automated lathe: 
Lathe on and Lathe Off.

PROBLEM:
No message appears

on ALPHA sign
“No Network Activity”

message appears on ALPHA sign
“NO BACKGROUND MESSAGE“1

 appears on ALPHA sign

POSSIBLE CAUSE:

• Network wiring fault
• PLC fault
• PD3000 fault
• ALPHA sign fault (possible sign 

hardware failure or a PLC is trying 
to display a message that was not 
programmed into the sign)

• Message(s) too long for preset file 
size

• Sign not plugged in or turned on

• Network wiring fault
• PLC fault
• PD3000 fault
• ALPHA sign fault
• ALPHA sign timeout because there 

was no network activity for at least 3 
seconds

• Sign address not correct.
• The sign has not received any 

message to display. (This is not an 
error condition.)

• Sign is receiving information, but 
the information is not for this sign.

1 This is called the “background message”. The Gateway Message Editor can be used to change the wording of this message.

How to get PLCs to communicate with ALPHA signs

What How

1.
Program Gateway device 
(Map messages and variables
to one or more ALPHA signs)

Gateway device (e.g., Profibus) software
(different for each manufacturer)

2. Create messages and variables 
and store them in ALPHA sign(s)

Gateway Messaging Software
(created by Adaptive)

3.
Program the PLC
(associate machine “actions” 
with the messages and variables 
created in Step 1 above)

PLC software
(different for each manufacturer)
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These are the steps to follow for this example:

1. Using the PD3000 Configuration Editor software, program the PD3000.

2. Using Gateway Messaging Software, program the messages and variables into each of the two ALPHA 
signs. The illustration below represents the type of information stored in each sign:

3. Using the software that came with it, program the Profibus DP PLC that will be sending information to the 
PD3000.

Register #

1
2
3
.
.
.
100
101
102
103
.
.
.
167

Description

Variable #1 (+ or - integer value)
Variable #2 (+ or - integer value)
Variable #3  (+ or - integer value)
.
.
.
Variable #100  (+ or - integer value)
Message Activation Register (the Message # to turn on)
Message Deactivation Register (the Message # to turn off)
Message queue
.
.
.
.

Message #

1
2
3
.
.
.
2000

Description

Message #1 (100-characters)
Message #2 (100-characters)
Message #3 (100-characters) 
.
.
.
Message #2000 (100-characters)

How messages and variables are stored inside ALPHA signs

Variable & Message storage

( with Gateway DP firmware)
ALPHA sign
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4. The complete setup for the PLC, PD3000, and ALPHA signs looks like this:
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